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Syllabus Plus

Printing & Reporting

This Syllabus Plus training guide covers printing and reporting data from Syllabus Plus (referred to as
S+ throughout the manual). It assumes some knowledge of the system. If you have not used S+
before, please contact Timetabling & Room Bookings on ext. 34009. Topics covered in this manual

are:

3

*

Using templates to produce printouts;

X3

%

Exporting data to Excel;
Editing templates and creating your own templates;

X3

S

3

0

Saving print templates.

If you have any questions when you have worked through the guide, please contact the Timetabling
and Room Bookings team on ext. 34009 or timetable @leeds.ac.uk.
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Syllabus Plus: Printing & Reporting

The printing and reporting functions in S+ are based around print templates, which are pre-defined
layouts/views. When you retrieve an image from the Timetabling and Room Bookings website, the
default print templates (i.e. those which are supplied with S+) will already be loaded. With the
templates, you simply select the data that you want to print, run the report, and it will be formatted
into a print-friendly layout for you.

Section 1: Using templates to produce printouts

When using templates to produce printouts from S+, there are two rules to follow to ensure success:

1. Select Print with the relevant window open — for example, if you are printing a staff
timetable, you need to open the Staff window, if you are printing a module timetable, you
need to open the Module window, etc.

2. Use Filter to select the records you want to print before selecting your template — for
example, if you are printing room booking timetables for each room in your school, you can
filter locations to show only your rooms, and print the timetables in bulk.

In this section of the guide, you will find step-by-step instructions for producing specific printouts. If
there are any printouts that you would like to be able to produce that do not appear here, you can
create your own templates, following the instructions in the “Editing and Creating Templates”
section of this manual. If you are unable to create the template you need, contact Timetabling &
Room Bookings for advice on 34009 or timetable@leeds.ac.uk.

In general, you should avoid relying on printed timetables wherever possible. Where they are used,
please ensure that the recipients are aware that the information may swiftly become out of date.
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Individual Location Timetables

If you wish to print a timetable showing bookings made in individual locations (for example, to

display on the doors of school-owned rooms):

1. Select Locations from the Timetabler drop-down menu.

2.

If you wish to print a single timetable for a specific room only,

clicking on it in the column on the left of the screen.

rse Planner (RELEASED
File Database Edt Yew Schedding Timetabler windows

ADC Clinie:
ADC Surgery 1
ADC Surgery 2

ADC Surgery 3

Astbuy MF [11.106)

Baines Wing dudiology [LG.21]

Baines Wing Audiology [LG-22]
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Baines Wing Audioloay (LG 24]
Baines Wing Audiology L5.25
Baines Wing Clinical Shills (3.21)
Baines Wing Clinical Skills (3.22)
Baines Wing Counseling Suie (3.24]
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select the name of the room by

Blenheim Tarace SR

Braga & Cluster (10.05)
Brag B Chuster (10.04]

Baines Wing SR (237

Baines Wing SR (306

Baines Wing SR (412

Baines Wing SR [6.22]

Baines Wing SR [6.23]

Baines Wing SR [G.40]

Baines Wing SR [G.41]

Baires Wing SR [G.42]

Blerheim Terrace S [1.01] Houss Mo, 1114

Blerheim Terrace SR (1.16] Houss Mo, 11-14

Blenheim Terracs SR (1.17) Houss Mo, 1114

Blenheim Terrace SR (G.02) House No. 1114

Blenheim Terrace SR (G.03] House No. 11-14

Elenheim Terrace SR [G.06) House No. 1114

Blenheim Terrace SR [6.07) House No. 1114

Blenheim Terrace SR [6.08] House No. 1114

Blerheim Terrace SR [6.11] Houss Na. 1114

Blerheim Terracs SA [6.12] House No. 1114
(

6.15) House No. 11-14
Botany House MF [G.06)

Botany House SFi [1.04)

Botany House SFi (1.07)

Braga 4 and B Cluster (10.04/10.05)

Business Sehool Cluster (2.21]

Business Schaol Maurice Keyworth Boardroom [1.02)

Business Schadl Maurice Keywerth SF (1.03)

Business Schodl Mauric Keyworth S [1.04) -

Total 763 Locations

Connected

of Leeds - 1011img =%
Com  Help
1= x|
] User Text & Tags Constraints Bvalabilty Usage Statts Timetable:

Name Hast Key Deparment Zare
[Baines wing MR (1.06) 1-01-086-2425-01 108 Healthcare =] [Baineswing |
Description Cost Band
[Meeting/S eminar Room [inone] =1
Contract Hours Masimum Hours Area Capacity
762 [4]31:00 Hows 782 [g] 100 Howss 62 2

Activiy Day Tine Madule -
DHS2004/TUT 01/ <Clirical Skills Requested> Thu 300 DAH5200401 .
DOME 1005/TUT 01 GpS Wed 500 DOME 100501 .
DOME1005/TUT 02 G0 wed 11:00 DOME 100501 .
DOME 3034/5MF 01 /01 Thu 1400 DAHS101402 -
DONET01 7/SMR C/Gp E Fii 300 DONE1 01703 -
DONE 3023/ 01/04 Thu 11:00 -
DIONE 2023/KS 02404 Thu 11:00 -
HECST0Z8/EAM 0101 Wed 500 HECS 102801 -
HECS1041,/TUT 01,01 Fii 1300 HECS 104101 -
HECS1090/CLIN Gp 1 wed 15:00 HECS10900 .
HECS1092/Persanal Safety Training/02 Fii 500 HECS10920 .
HECS1093/5MA 01,01 wed 1300 HECS1093m .
HECS2080/5MA 01,01 Fii 1300 HECS2080M .
HECS2136/5MA <SEM 26> Mon 10:00 .
HECS2136/5MR <SEM 26> Mon 1300 -
HECSHE7/GWRGp N Fii 300 HECS 316701 -
HECS3177/5MR 02/03 Wed 10:00 HECS 317701 -
HECS3177/5MR 02/04 Wed 1300 HECS 37701 -
HECS3138/31 (13/51 46M /51 20M LEC 01014 HoTu 500 “H
HECS3202/5MR 01,04 Thu 1300 HECS 32020 -
HECS3218/IND 04/ wed 10:00 HECS3218m .
HECS3220/EXAM 001 Thu 12:00 HECS322002 .
HECS3226/GWk 02/02 weTh 500 HECS3228m .
HECS5002MALEC D1/01 Thu 1400 HECS5002MM .
HECS5003M/ERAM 01/01 Thu 1300 HECS5003M03 |
HECS5203M/EYAM 01,01 Wed 300 HECS5203M01 - IS
Time Utilzation: in use 1860 periods (930:00)

5 10 15 20 0 Ed 40 45 50
wi | wo| rer| o | o] con| Dis | Koy Heffesh Duplicats
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Syllabus Plus: Printing & Reporting

3. If you wish to generate printouts for each of your school-owned rooms, go to the View drop-

down menu and select Filter.

_ ol x|
Filter Locations by Objectz Include :
Department j Communications Studisz | W Fully scheduled
Cammunity Paediatrics £ ¥ Partially scheduled
Computing ¥ Unscheduled
Dental Surgery
Laak far; Dentistr
% Objects / Groups
 MNaone Eroupz
Mot Uzed Departments  a
ShwS — -
: “WHE Departments o Eilter I
From Window. . I _Abways allocate level 1 :
Do niok allocate lewel 1 Unfilter |
_ProgCatall C | |
Teaching denartments ElEE

weeks B2 weeks from 1 [26/7/10) to 52 [24/7/11)

1 5 10 15 20 25 30 35 40 45 50
TTT T T I T T TT IT IT T IT TTT TT TIT TTTTT TTT TTITTTTTTTTTTT

Choose Department from the Filter Locations by: menu, and select your school in the Objects
box (as shown above). Click Filter.

Hold down the Ctrl key and select the names of the rooms for which you require a timetable by
clicking on them.

=lmix]
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I == z
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Clotmmorkers Soulh Buldng e [1.046) o =
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Lk Bubing CAD (L 1. 53]
Lk Busking b L G 6.32)
Lk Buking MA L GHG 51
T Urasions
5 0 1 2 = @ ) an 5 50
Vg 18 of 759 Lot
Connmcted T [ | wo | [re| ma | o | G 0w | oukems |

Timetabling & Room Bookings
Version 1.3 November 2010 Page 5



Syllabus Plus: Printing & Reporting

6. If you need to print timetables for all your locations, press Ctrl and A on your keyboard to select
all the records.

7. From the File dropdown menu, select Print....

Printstyie x|

D ata Feport Periods:

Spreadsheet (05:00 09:30 11:00 12:30 14:00 15:30 1?:IZIIZII‘I E:EEIIEEI:EIEIIE 30
Compact T T T ]
b azter

| ndividual Draps:

Text Spreadshest Mon  Tue ‘Wed  Thu Fri Sat  Sun
Text Repaort
. S
Location |ndividual I Selected Periods j |1 g |ﬁ
I Selected Days j |5 @
Wheeks to Print;

1 & 10 15 20 25 30 35 40 45 HO

[T Show all Templates?
Template Organizer. .. | Frint All... |®| Eile... Cancel |
N

4
S~——

8. Select Individual and Location Individual, as shown above, and select the time periods, days and
weeks you wish to print. In this example, we are printing the timetable of room bookings
between 9am & 5pm (09:00 & 17:00), Monday to Friday in S+ week 10.

9. Click Preview. If the resulting preview appears blank, but you know that bookings have been
made, click Cancel (bottom right corner), and then click Preview again. This should cause the
bookings to appear.

B rdivinhasd Prink Location
University of Leeds

[imetable: Clothworkers Central Building SR 1 (W
Manimum Capacity: &6 Wookn solocted for printout: 1 {27 Sep 2010 to 03 Oot 2010)
B o 1 e
Mon [McP resrson Laura
= HESHERTTFRE 70T
fHeney Pralip, My
[Hamis Chmstonhaer Mr
[ Tue [Cloments Lucanda Miss
[Lirve ot b K M1
[Gaston Elzanath, Mo
=
(Wed
e TESHTS0TFRE 11
Thu [oean.tars miss i, mmun:wmo
T Tz JA - T 01 JA .
N
T T O S| e
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Syllabus Plus: Printing & Reporting

10. Click the Printer Setup... button (circled above). This will open the Print Setup box

Print setup 21x|

— Prirter

Mame: I SMCEMTRALMTPRIMT wyregprt294 j Properties. .. |

Statuz: Feady
Type: HP Laserlet 4300 F5
“Where:  EC Stoner 11.84

Comment: Space Management

— Paper Orientatiamn
Cize: | 4 =] ™ Partrait

Source: I Automatically Select j g L

Metwork... |

11. Make sure the Orientation is set to Landscape, as above, and click OK.

€ Individual Print Location

University of Leeds

Room Timetable: Clothworkers Central Building SR 1 (WD 1.60)
fMaximum Capacity: 55 Weeks selected for printout: 1 {27 Sep 2010 to 03 Oct 2010}
oo 30 fio-on [io:30 Trioo =0 [iz0n frz:30 [iz00 330 [lann fra:z0 [i5:00 [i5:a0 [iE-00 =0
DESN002001/LEC 1/01
HMon McPherson Laura
-1
DESN256401/PRC 1/01
Henry,Philip,Mr
Hartis,Christopher,mr
Tue Clernents, Lutinda Miss
Laycack Kewin,Mr
Gaston Elizabeth Mrs
a1
HWed
DESN156001/PRC 1/02 DESN156001/PRC 1/01
Thu ScoftJane, Miss Clements Lucinda Miss
Clements Lucinda Miss Scoft Jane Miss
i1 o1
DESN3311/3342/PRC 1/02 JA DESN3341/3342/PRC 1/03 JA
Fri Harris,Christopher,Mr Harris, Christopher,Mr
it o
Printed on 03 Nov 2010 at 17:48 Timetable for: Glothworkers Gentral Building SR 1 (WD 1.60) Printed by Lisa Whiteley

T () A
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Syllabus Plus: Printing & Reporting

12. Click Print All to send the timetables to the printer. If you have selected more than one room,
then the timetable for each one will be printed on a separate page.

13. If you wish to view all the timetables before printing, use the drop-down menu (circled above) to
look at each one in turn.

14. If you want to print the timetable you are viewing, rather than all the timetables you’ve
selected, click Print... instead of Print All.

Master Location Timetables

The Master Location Timetable creates a print out with a page for each day of the week, showing
only the locations where there are bookings. It is useful for gaining an overview of usage for the
week.

1. Select Locations from the Timetabler drop-down menu.

2. To select all the rooms owned by your school, select Filter from the View drop-down menu. As
described previously, select Department from the Filter Locations By: list, and select your school
in the Objects box. Click Filter.

3. Select all of your locations by clicking Ctrl and A on your keyboard.

ourse Planner (RELEASED 3.9. 36) at University of Leeds - 101 1.img —|=1x]
Datsbase Edit Yisw Schedulng Timetabler Windows Com  Help

cations - filtered by Departments (Communications Studies) —|=1x]
3

]

User Text & Tags Conshaints Awailabillty Usags Starts Timetable

Name Host Key Department Zone
[ [ Commurications Studies =] [Clotworkers =1
Desription Cost Band
[inone) = |
Contract Hours Hawimum Hours Area Capaciy
210 [ 105:00 Hours 210 [ 105:00 Hours
Aty Doy Time Hodule
Time Utiization
1 10 15 ) 25 ) ) 40 45 50
Viewing 10 of 769 Lacations
Connected we | wa| ret| Ao w0 | con| oi || B ey Fefiesh Duplicate
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Syllabus Plus: Printing & Reporting

Please note: It is advisable to select all locations to ensure that no bookings are missed from the
master timetable. If a room does not have any bookings it will not appear on the printout.

4. Select Print... from the File drop-down menu.

5. Select Master and Location Master as shown below. Select the time periods, days and weeks to

be printed. In this example, we are printing all bookings between 9:00 and 17:00, Monday to

Friday, in S+ week 10. Click Preview.

Print Style

X

D'ata Report Periods:

Spreadsheet 0200 0530 11:0012:3014:00 15:20 1?:EIEII'I E:SDIED:DDIH a0
Lompact [TTTTTTTITTT]
[ ndividual Draps:

Text Spreadsheet Mon Tue  wed  Thu Fri Sat Sun
Text Report

[
:|_ocation b aster
Location Usage
Location kMaster DD

IDaj.lperF'age j |1E @
[avtofit Objects =] [0 [3]

Wieeks to Frink:
1 &5 10 15 20 25 30 3 40 45 A0

[ Show all Templates?

T emplate Organizer... | Print All... | Prewview. .. | File... |

Cancel |

6. Once the timetable is displayed, check the Printer Setup (as described previously in “Individual
Location Timetables”) to ensure that the page orientation is set to Landscape.

.
IUniversity of Leeds Printed 04 Nov 2010

Master Location Timetable
|[Week selected for printout: 27 Sep 2010 to 03 Oct 2010

[The capasity ot sach Lacation is shown in the indhidual sells

B
[Clothworkers North Building Conference room (1.18)

lclothworkers North Building Edit 1 (G.06)

[Clothworkers North Building Edit 3 (G.19)

[Clothworkers North Building MR (1.19)

I3 o o
[Clothworkers North Building New Media Lab (G.04) ot ‘ o
1020 12
[Clothworkers North Building Newsroom (G.23) o1 Tz
o | | foa

[Clothworkers North Building SR (1.17) e | ‘ ‘ ‘ ‘ ‘

Print Date: 4 Nov 2010
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Syllabus Plus: Printing & Reporting

7. Monday is displayed automatically. To view other days, click on the up and down arrows in the

page number box (circled above).

8. Click Print All to print all the pages, or Print... to print only the page you are viewing.

Please note: if a location has a booking on any one day in the week, it will appear on each page of

the printout.

Staff Timetables

As staff timetables are now available online, you are unlikely to need to provide members of staff

with printed timetables from S+. Staff should be directed to the Timetabling and Room Bookings

website where they will find, under the “Info for Staff” section, a pdf file called “Accessing Staff

Timetables” which gives details of how to access individual staff timetables online.

However, if you

do need to print out a staff timetable, you should make staff aware that, as is the case with all

printouts, the timetable is likely to become out of date soon after being printed and that they will

need to check for updates.

Please note: these timetables will only contain staff data if staff have been assigned to the activities

they teach on S+.

1. Select Staff from the Timetabler drop-down menu.

2. Select the member(s) of staff whose timetable you need to print — do this by selecting them
manually from the list on the left hand side of the window or filter by Department and press Ctrl

and A on your keyboard to select all staff belonging to your school.

3. Select Print... from the File drop-down menu.

Data Report
Spreadzheet
Compact

b azter

Indiwidual
Text Spreadshest
Text Repart

| Mone

[T Show all Templates?

Template Organizer...

Periods:

02:00 03:30 11:00 12:30 14:00 15:30 17:00 1830 20:00 2130
[TTTTTTTTITTI]

D aps:
kon Tue wied Thu Fri Sat Sun

ISeIected Periods :I |'IE @

ISeIected Days :I |5 @

‘weeks to Print:

1 5 10 15 20 25 30 3/ 40 45 50

(O OO O T T T N T T T T
Frint Al Prewview. .. | File. . | Cancel

Timetabling & Room Bookings
Version 1.3 November 2010

Page 10



Syllabus Plus: Printing & Reporting

4. Select Individual and Staff Individual. Select time periods, days and weeks to be covered by the
printout.

5. Click Preview....

ividual Print Staff

University of Leeds School of Physics and Astronomy:

Staff timetable: Adolf,David.Dr

Weeks selected for printout: 27 Sep 2010 to 02 May 2011 Total Hours in use overselected weeks: 286:00

%00 [3:30 10:00 [10:30 11:00 [i1:30 200 12:30 [13:00 1330 [14:00 [14:30 [i5:00 15:30 [16:00 16:30
FHYS232001/LEC 101 FHYS001601/LES 1/01 FHYS317001/LES 1/01

Roger Stavens

HMon [chemisty LT B 2.17) 712 10,13

EC Stoner SR (8 62)

411 1423, 24 1423, 24
PH{75317001/LEC 2001 [PHVSZ3200 1P RE 1 (51701
Tue EC Stoner SR (8.02) Bragg A and B Cluster (10.04¢10.05)
1423, 24 1-11
PHYSZ32001/LEC 2001
Rager Stevens
wed LT 24 (10.24)
1423, 24
PHYS1060/PHYS1ZE0/PRC 1703 JA PHYS122001/LEC 1 PHY5122001WHS 1(S2p01
l(s2y01
p— ragg A an uster (10.04¢10.08)
111 1422, 24 1423, 24
Fri
Printed on 04 Nov 2010 at 17:16 Timetable for Adolf.David.Dr Printed by Lisa Whiteley =
Ll »

T ( )

6. To view timetables for the other members of staff you’'ve selected, use the drop down list
(circled above).

7. Ensure that the page layout is set to Landscape using Printer Setup..., and then print the
timetables using Print All, or Print... for a single timetable.

Module & Programme Timetables

Individual Module and Programme Timetables can be printed using the same method as described in
the Staff Timetable section above.
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Syllabus Plus: Printing & Reporting

Student Timetables

Personalised student timetables are available online. However, you may need to provide students
with printed timetables in the event that they cannot gain access to the web. As with all printouts,
you should make students aware that the timetable is likely to become out of date soon after being
printed, and that they will need to check for updates.

Please note: student activities will only appear on these timetables if the student has been allocated
to the activity in S+.

1. Select Student Sets from the Timetabler drop-down menu.

2. Select the students whose timetables you need to print — do this by selecting them manually
from the list.

3. Select Print... from the File drop-down menu.

Print Style x|

Diata Report Periods:
Spreadshest 08:00,09:30.11:0012:30 14:00.15:30.17.00 18:30 20:00 21:30
[TTTTTTTTTT]

Days:
b ar Tue Wied Thu Fri Sat Sun

ISeIected Periods j |1E @
ISeIected Days j IE @

Wieeks to Frink:
1 5% 1 15 20 25 30 35 40 45 50
[ T A T T T T
[T Show all Templates?
T emplate Organiser... | Print All... | Prewview. . | File... Caricel

4. Select Individual and Student Set Individual as shown above. Select time periods, days and
weeks to be covered by the printout.
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Syllabus Plus: Printing & Reporting

5. Click Preview....

dividual Print Student Set

School of Performance and Cultural Industries
Student Set timetable: (200419455)

University of Leeds

Weeks selected for printout: 27 Sep 2010 to 08 May 2011

GO0 [Ga0  [000  [i030  [H00  [11.3  [1z00  [1230  [1300  [1330  [1400  [1&30 1500  [1530  [ie00  [es  [ino0  [17a0
PECIZ10601/PRC 402

Wichael Sadler SR (LG.10) 123,24

Gardner Anthony,Dr
HMon

PECIZ10601/LEC 1/01 |PECIZ10601/LEC 2001

tichas! Sadier RBLT  [Roger Stavens LT
(LG x09) 17 7.17)

1

Falme Soott, e Falmer,Scott,br

FECIZ10401/SMR 104 [PECIZS0101/FRE 102

Tue f(:";':;w‘"g 3R olelothworkers South Building Studio 1b (6.41b) =1

Stanziola,Javier 0 G rady, Kathleen, D
PECIZ0601/PRE 5,02

Mwed [Michael Sadler SR (LG.10) 143,21

G ardner, Anthony,br

PECIZ50101/5DL 1102

Clothwoikers South Building Studio 16 (G.11k) =1

Thu PECIZ10901/LEC 1/01 |PECIZ10901/5MR 1104

Froger Stevens

123,24
LT 22 (10M.22) Hillary Place
Kiszzty.Phillip.Dr SR (124)
Bannen Fions,Dr

a2

Kiszely. Phillip. Bt

PECI310601/FRE 602
Fri |Michael Sadler SR (L6.10) 123,24

Gardner Anthony, Bt

Print Date : 04 Nov 2010 Timetable for r2|]l]41 9455)

) I (| ——) e

6. To view timetables for other students you’ve selected, use the drop-down list (circled above).
The student’s name and ID number will appear here, and also at the top of the page although, in
the example shown here, the name has been blocked out.

7. Ensure that the page layout is set to Landscape using Printer Setup..., and then print the
timetables using Print All, or Print... for a single timetable.

Timetabling & Room Bookings
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Syllabus Plus: Printing & Reporting

Class Lists

The Class List template allows you to print a list of students linked to a particular activity. Although

previously this template was distributed as a separate file which could be downloaded from the

Timetabling & Room Bookings website, it is now one of the default templates installed as standard.

1. Open an Activities window from the Timetabler drop-down menu.

2. In the list of activities on the left-hand side of the window, select the activity or activities for

which you need a class list.

ourse Planner (RELEASED 3.9.2 36) at University of Leeds - 1011.img
File Datahase Edit Yiew 3cheduing Timetabler windows Com Help

LINGZ33001/5MR 1/04

LING233001/5MR 1/05 D
LING303001/LEC 101

User Tert & Tags Deelivery Sequencing Fesoucs Pools

Availabilty

Usage Starts Timetable

LING303001/5MR 1/01

LING303001/5MR 1402 Name Hust Key

Department

Module

IL\NG31EUUVLEC1/U1 wWDCHTIO?

Description

LING3060/LEL 1401
LING3060/PRC 1/01
LINGZ12001/LEC 1/01

Linguistics and Phonetics

LING312001 -
LING313001
LING314001

LING312001/5MR 1/01
LING312001/5MR 1/02
LINGZ12001/5MR 1/03
LINGZ130/526TM/LEC 1/01 JA |ED

LECTURE
I Size [plan] Type Total Cost

@ [Ecw e
CING120/5261M/SHA 170104, Section D Fach
CINGI13007ALEC 1701 ection actor

Sections

LINGF13001/5MR 1/01 | &
LING313001/5MR 1/02

LING313001/5MR 1/03
LINGZ14001LEC 1/01

Teaching week pattem: 11 weeks flom 27 (24/1/11) to 41 [8/5/11)
LINGZ14001/LEC 2/01 1 ] 10 15

20 25 an

LING214001/5MR 1401 N N N N N N N N N N I

LING314001/5MR 1/02
L\NGSNUUVSMH 1/03

Duration

[ [Ez00Houws

Tue 300 - 11:00 <Papne Wonlidge Futh.Dr; Michael Sadler 57 (LG 19 - Ainley, J&
(200343571, Bmbroziak, H (200457755, Blythe, K [200468241), Butler, v (200347080),
Chiysostomau, M (200391 735), Diawlbney, & [200331689), Deamen, KL [200307622), Gabbitas,
R [200346334]

Suggested Daps

LING318001/5MR 1/02
LING318001/5MR 1/03
LING318001/5MR 1/04
LING319001/LEC 1/01
LINGZ15001/5MR 1/01
LING319001/5MR 1/02
LING319001/5MR 1/03
LINGZ20001/LEC 1407 <10, 12-15, 17-20>
LINGZ20001/LEC 1401 <11>
LINGZ20001/LEC 2/01
LING321001/LEC 1401
LING321001/PRC 1/02
LING321001/PRC 1/03
LING322001/LEC 1401
LINGZ22001/LEC 2/01
LINGZ22001/5MR 1/01
LING322001/5MR 1/02 |
LING322001/5MR 1/03
LING3230/5200M/LEC 1/01 JA
LING3230/5200M/PRC 1701 J4
LINGZ230/5200M/PRC 170204
LING323001/LEC 1401
LING323001/PRC 1/01
LING323001/PRC 1/02
LING325001/LEC 1401

LING325001/LEC 2/01
LINGZ260/6321M/LEC 1/01 JA
LING3260/5321M/LEC 2/01 J&
LING326001/LEC 1/01

LING326001/LEC 2/01

LING326001/wKS 1/01

LINGZ26001/w/KS 1/02
LING3290/5292M/LEC 1/01 JA&
LING329001/LEC 1401

LING329001/LEC 2/01
LING323001/5MR1 /01
LING323001/5MR1/02
LINGZ23001/5MR1./03

LING330001/LEC 1/01

LING330001/5MR 1/01

LING330001/5MR 1/02
LINGSOTTMOT/LEC 1/01
LINGSOTTMOT/SMR 1/01

LIMGAO MO A FC1/01 =

™ Monday

¥ Tussday

[~ Wednesday

™ Thursday

I~ Fiiday

™ Saturday

™ Sundap

Suggested time
0300 =1

Set Time.. |

Farents

Children

Total: 43076 Activities =| Scheduled? v

Connected

] o] ] o] 0] | o]

Koy Heffesh Duplicats
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Syllabus Plus: Printing & Reporting

3. From the File drop-down menu select Print...

Print Style

Drata Repart

Compact
b azter
| ndividual

Text epu:urt

Spreadshest

[none]

cohf offise hest

[ Show all Templates?

T emplate Organizer... |

Periods:
0800 09:3017:00 1230 14:00 1530 17:00 18:30 20:00 21:30

Draps:

Mon Tue wed Thu Fri Sat Sun

[T Combine Objects?

Wieeks to Frink:

1

5 10 15 20 25 30 35 40 45 50
CLLCERLLEEE L] B

Print All... | Prewview. .. | File... | Cancel

4. Select Text Spreadsheet and Class List as shown above, and click Preview.

Belcher Kenneth Dr
Gartland Sam Mr
Parkinson SR (B.10)
Monday 16:00-17:00

10-20
Student Hame

€% Text Spreadsheet Print Activity

Attendance List for activity: CLAS180001/LEC 1/01

Student ID Number

Email Addiess

Riddell, CL (200546057)

200546057

cNOc2i@leeds. ac. uk

Weyer, PE (200533241)

200533241

cl0pem@leeds. ac. uk|

Walker, K (@200534824)

200534824

cl0kwiEleeds. ac.uk

Mecaul, H (20054667 1)

200546671

cl10it leeds.ac. uk

Dymond, JA (200533345)

200533345

cl0jafd@leads. ac.uk

Paget, CJ (200527469)

200527459

cl0cjap@leeds. ac.uk

Printed by Lisa Whiteley at 19:04.0n 41710

)
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Syllabus Plus: Printing & Reporting

5. Click Print All to print the list.

Lists

Finally, S+ has a template called “Generic Object List” which is found under Spreadsheet in the Print

window. This template produces a list containing the Name and Description of the information you
have chosen. You may find this useful to:

e Print a list of modules;

e Print a list of scheduled or unscheduled activities;

e Print a list of all students enrolled on specific modules or programmes of study;
e Print a list of all students belonging to your school.

Before selecting Print, make sure that you have selected all the items that you wish to print details
of. Do this, as with all printouts, by either manually selected them from the list on the left while

holding down the Ctrl key, or by filtering to the information you want, and pressing Ctrl and A to
select all.

The training guide will use an example of printing a list of unscheduled activities. The same
technique can be used for other examples mentioned above.

1. Select Activities from the Timetabler drop-down menu.

2. Select Filter from the View drop-down menu.

ilter

Filter Activities by
D epartment j

Ohjects

Chermiztry
Child Dental Health
Civil Engineeing
Clazzics

Laoak for: Colour Chemistry

Combusztion & Erer
¥ Objects / Groups ir=h "
" Mone Groups

Include :
[T Fully scheduled

...........................................

Mot Used Departments  a
S — _
WRE Departments e | Filter I
_Alwayz allocate level 1 -

_Dao not allocate level 1 Unfilter |

_ProgCatall - I Cancel |

weeks: 52 weeks from 1 (26700 0 52 [24/7411]
1 5 10 15 20 25 20 5 40 45 o0
EEEEEEEEENEEEEEEEEEENEEEEEEEEEENEEEEENENEEEENEEENEER

From ‘window. . |

Timetabling & Room Bookings
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Syllabus Plus: Printing & Reporting

3. Asshown above, filter by Department, and select the name of your School from the Objects box.
On the right (circled above) deselect Fully scheduled and Partially scheduled by un-ticking the
boxes, leaving Unscheduled selected. Click Filter. You will then be viewing only unscheduled
activities for your department.

Please note: this list also includes the Parent activities of Jointly Taught activities.

urse Planner (RELEASED 3.9.2 36) at University of Leeds - 1011.img -l=lx|
Scheduling  Timetabler Windows Com  Help

red by Departments (Chemistry) _l=|x|
o S D User Text & Tags Dielivery Sequencing Fiesource Padls Availability Usage Statts Timetable
Name Hast Key Department Module
| Chemisty =] [CrEMzzanT P
CHEM227001 =
Desciiption CHEM234001
CHEM235001 =
I Size fplan) Type Total Cost Seclions
Fy
I B =
Section [D Factor
[ 1
Teaching week patlem; 23 weeks fom 9 [20/9/10) to 41 (8/5/11)
1 5 10 15 20 n S 40 45
O 5 D D D O 5 O O O O O N |
Duration Suggested Daps Suggested time
7 Monday Sei e, |
Parents
7 Tuesday
[¥ Wednesday
¥ Thursday
Childien
7 Fiiday
7 Saturday
¥ Sunday
Viewing. 44 of 42773 Activities =|
Connected wi | wo| Ref| RO | LO| Con D\s| Hodiy Aefiesh Duplicate

Timetabling & Room Bookings
Version 1.3 November 2010 Page 17



Syllabus Plus: Printing & Reporting

4. Select all by pressing Ctrl and A, then select Print... from the File drop-down menu.

Print Style

| [ata Heiurt

Compact

b azter

Individual

Test Spreadzheet
Texst Repart

conzec acls

*COMF activity list

*Conf Office I__ist Wwheeks to Print:

“weekly booking sheet W 1 6 10 15 20 25 30 3/ 40 45 GO
Student data NN RN AN NN NN NN NANNANAD

[T Show all Templates?

Template Organizer. .. | Print All... | Fresiew. . | File... |

Cancel |

x|

5. Select Spreadsheet

Spreadsheet Print Activity

and Generic Object List, as shown above,

Hame
[CHEL Yeur 1 Homewn
e
e mat00LLES L
[cHm 00 LEL 2
fcHEE 18001

[cHmE 15001
cHE 18001
[cHmE 15001
cHE 18001
[cHmE 15001
cHE 18001
[cHmE 15001
cHE 18001
[cHmE 15001
cHE 18001
[cHmE 15001
jcrmEat 0 1LES L
[cHm B0 Er 2
cmEat01wES
[CHE G501 LED
[cHE B2t s01LLEC
[cHEEET 0L EE
cHEE 27101 E:
[CHEL G300 1/ R
crm e
[cHm B 3001,
crm e
[cHm B 3001,
cm e 00
BN

cHE s LoD,
N
cHE s L7
[cHm G5
CHE S35 1L E
[CHE G126 1BWE
CHE 2261 LEL 1
[CHR G127 1w
crmsnnILE:
e
crm s LE:
e
crmsas0m1LE:
[CHm G2 0n 1 s 101

Edit

| T ]

6. Click on Print All to print the list.

and click Preview....

Please note: In Activities, you also have the option “Activity List” — this produces a list similar to that
shown above, but containing more details about the activity, for example day/time, duration and

location. You may prefer to use this.

Timetabling & Room Bookings
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Syllabus Plus: Printing & Reporting

Section 2: Exporting Data to Excel

1. If you need to create a spreadsheet rather than printing a list directly, click Cancel to exit the

Print Preview. This will take you back to the Print Style box — click File...

B x|
9

Select File Farmat.

HTML | HTMLecss | Cancel |

2. Select Text in the Select File Format box, as circled above.

3. Specify a name for the file, select the folder you wish to save it in and click Save.

Save in: I@' Desklap j £k El-

' My Computer

- My Mebwork, Places

1011

1112

Cascade list for Portering contact_files
Datasync

Training images 2010

5 Csmt_Shared

57 Shorkcut ba Apps

{50 Shorteut bo booking confirmations
E] staff list

Em

File name: ILInsu:heduIed activities. bt j Save I
Save as lype: I,-’:-.II Files [*.7] j Cancel |
P

4. The file will be saved as text format. To open this file, open Microsoft Excel.

5. Select File/Open and change the File Type box from “All Microsoft Excel Files” to “Text Files”.
6. Navigate to the folder where you saved the file.

7. Click on the filename to select it and click Open.

Timetabling & Room Bookings
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Syllabus Plus: Printing & Reporting

8. Once you have selected your file, Excel will take you through an Import Wizard. Simply click
Next to accept all the defaults, and click Finish on the third screen. Your file will open as a
spreadsheet. When you have done this, you may want to save it as a spreadsheet so that the file
can be opened in future without needing the Import Wizard.

Please note: If you prefer to open files through Windows Explorer rather than opening Excel first,
right-click on the file and select Open With, followed by Microsoft Excel. The file will then be
opened automatically as a spreadsheet.

Section 3: Editing and creating your own templates

If the existing templates in S+ do not extract the information you require, you will need to either
adapt an existing template, or create your own. The following examples focus on editing the Activity
List, and creating your own Location List template, but the principles used can be applied for any
kind of template.

Editing templates

To edit an activity list template:

1. Open an Activity window from the Timetabler drop-down menu.
2. Click on an Activity name on the left of the screen.

3. Select Print... from the File drop-down menu.

4. Select the template that you want to edit — for this example, select Spreadsheet and Activity List
as shown below, followed by Preview...

Print Style x|

Compact

M aster

Individual

Text Spreadsheet
Text Report

[none]
Genenic Object List

conzec acts

*COMF achivity list

*Conf Office List ‘wieeks to Print:

“weekly booking sheet /5 15 10 15 20 25 30 35 40 45 &0
Student data LLCCEEEECEEE LR

[T Show all Templates?

File.... | Cancel |

Template Organizer... | Print All... |

Timetabling & Room Bookings
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Syllabus Plus: Printing & Reporting

5. Click the Edit button in the bottom left of the screen.

Spreadsheet Print Activity

e of Deparomert Antivity Hane Gime Dy Tone Inmation Lowarion (delimited) Weeks
Gl Engmeerng. [EVELSOVLEG 101] 170 [Man] 500 | 100 (ol ineering LT A (L1 111 ]

. —
6. The Edit functions will appear on the right of the screen, as shown below:
preadsheet Print Activity
M of Deparnmert | Activity Huome Size Dy Time [umion Location (delinuired) Whaks “COMF activity list
Civil Engwerimg  CIVELF060L/LEC 101] 170 [Mon [ 2:00 | 1200 [Civil Bngimeering LT A (1.10)] 1-11 “Conf Office List
“Student data
“weekly booking sheet '

Generic Object List
CONEC acts

Ciete Templats

Template Drgariser

Template Class:

Dptions

Parameters

Change the name of the template in the box circled above to whatever you wish to call it and
click Create Template directly beneath the box you have just amended. By doing this, you are
editing your own version of the template rather than the original. The name of the template you

have just created will appear in the list above.

Timetabling & Room Bookings
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Syllabus Plus: Printing & Reporting

Right-click anywhere on the white area of the screen, and select Header Editor...

Header Editor

There are three main areas of the report which can be edited — the header, footer, and columns.

=10 x|

— e
¥ Show Accessors (ﬂew Line m dacld Femove
’.I\ N— Apply |
< String ) ;I
ather | &I
LI Ll Cancel |
— Colours: Shading: Format:
Text: inone] - Colour: I [hore) ;I I ;I
B ackground: [rome] - Texture: [none] -
—Justification; —————  Wwrap shyle [none] -
Harizortal: [ = T Faorce wrap? -
Wertical Eﬂg D elirniter I_
Eont... | 2| [Click Font...] Borders...

Please note: You will see that Show Accessors is selected (circled above). S+ uses the word

“Accessor” to refer to the fields that you can choose to include in your report.

9. The Header will be repeated at the top of each page in your report. You can include text
(referred to in S+ as “String”) or fields from S+ (“Accessors”).

10. To include text, click the New Line button, then select String on the left of your screen.

11. Type the text that you wish to include in the text box under the New Line button, then click Add
and your text will be added to the header as shown below:

: =1olx]
% hig et will show it the headeE
¥ Show Accessors Mz L [ — oK
™ Edit Al
This tant will shows in (B Toes: =] _ ey |
Activities
ather | Unda |
= E
Cancel
—Colours: Shading: Format:
Text: [none) - Colour. I (none] LI I LI
Backaround: [hane) - Testure: (hone) -
- wirap styls {rore) -
Harizantal = Foroe wiap? -
Wertical: = BES] Deliriter I_
Eont.. | | [Click Font_) Borders... |
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Syllabus Plus: Printing & Reporting

12. On the Header Editor, click Apply and then OK to apply the change.

5] x|

=CONF activity fist
“Cont Office List
“Student data

=weekly booking sheet
ctiniy List

Generic Object List
congec acts

Thie text vrill shove i the eader =
i T Diy Tome Dwgion  Locarion (elimited)  Waske
Civil Engineering [CIVELG200LLEE 3701] 170 | Fui 1000 ] 100 _[Givil Ergineering LT A (LI0)|5-25, 31]

test Activity List

Create Template

Template Organiser

Template Clsss:
Bctivily -

DOptions

Parameters

13. The text you have entered will be displayed at the top of the page, as circled above.

14. You can also edit the footer — this determines what will be displayed at the bottom of each page.
To do this, right-click on the main part of the page again, and select Footer Editor....

15. If you wish to add text to the bottom of the page, you can use the same method as the header:
click New Line, String, type in your text and click Add.

16. You may also wish to add standard text at the bottom of the page. To view options for this, click
other on the left of the screen (circled below).

=101 %]

¥ Show Accessors Bz L fcld e
[ Edit &l
- =] Apply |
LI Unda |
4 »
FrETCman —I _l Cancel |
- Institution &wvailable
-Page Mo _ . PR )
- Period Length Colours: Shading: Format:
- Print D ate . .
- Print Tirne fest [rane) Celour I[nu:une] ll I ll
+ User B ackground: a— Texture: [mons) -
~Justification: “wirap style: [none| -
Horizantal: Force wrap? Il
Wertical: Ezlg Dreliriter I_
Fant.. I xl [Click Eant...] Borders...

Timetabling & Room Bookings
Version 1.3 November 2010

Page 23



Syllabus Plus: Printing & Reporting

17. To add an item, click the New Line button, then click the item you wish to use, and click Add.
You may find it useful to include Print Date and Print Time in the footer — this is helpful in

working out how recently a list has been printed, particularly during the compilation of the

timetable when information frequently changes. These can be found in the “other” list as

circled above.

18. You can use a combination of text and automatic fields.

ooter Editor

=1olx]

O

Frinted on < Print Date > at < Print Time > by é;: zer - Name§

W Show Accessors

Mew Line Add Bemove
[T Edital
by ;I
hd|
K1 [/
|—Culuurs: | |—Shad|ng: |

Apply

Undo

e

Cancel

Format:

19. In the example above, “Printed on”, “at” and “by” are all text strings, and <Print Date>, <Print

Time> and <User-Name> are all selected from the “other” list. To combine elements in this way,

click New Line, followed by string, then enter your first item (in this case, “Printed on”) in the

text box and click Add twice:

ooter cditor

=k

]

¥ Show Accessors HNew Line | Bemove |

I Edital
Printed on ;I
]
Kl o
|—Cnluurs: | |—5hading: |

Apply

Undo

e

Cahcel

Format:

20. It will appear twice, as shown above. Click on the second item (circled above) and change the

selection as shown below — your item will update accordingly.
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Footer Editor

Frinted on ? Frint [ ate §

¥ Show Accessors

-

String

Mew Line Add Remove Ok

Printed on £l

mn

Activities
| ather Unda
ﬂ ﬂ Cancel
—Colours: Shading: Format:
Text: [none) - Colour. I [none) j I Date j
Background: o] = Texture: [mone) = I d/msuy j
~Justification ——————  Wrap syl [nane] -
Honzontal: Force wrap? -
Yertical: Eﬂg Drelimiter I_

Font.. | X| (Click Fort...) Borders... |

21. Click Add to add a third item, edit as required — in this example, alternating between “strings”
and “other” items, clicking Add in between. Continue until your footer is complete. Click Apply
and OK when you have finished.

22. Finally, you will need to edit your columns. Right-click again and select Column Editor.... The
currently selected columns are shown on screen:

T dito =101 ]

Mame of Department Activitp Mame Activity 1D Size tMadule 1D Cray Tirne Cruration Staff [delimited)

T einess Sohoon JLIES 319001 /SMP 1708 [#SPLUSO7DEDE 23 15117 Fri 10:00 1:00  |Leonidou, Constantinos, Dr Bt Ligirn
Business School JLIBST00002/LEC 14001 [HSPLUSO7DESD a8 27375 Thu 11:00 200 |Undensood, Sarah/Duff Gerrard [Parki
Business School JLYBS101002/LEC 1/01 [#SPLUSOFDEEZ 50 27376 ton 2:00 200 |Undensood, Sarah tdichs

Add | Hemove | & Edit Selected Colurmn o
—— 0 Edital
Activities v
+ Dlepartrnent ' Edit Column Titles Apply

{1l

|
Unda

¥ Show Grid Lines?

¥ Show Colurn Titles? Cancel
— Colaurs: Shading: Colurmn Data Farmat:
Text: [none) = Colour: I [hone] LI I [hone) LI
Background: [More] - Texturs: [rarne] -
rJustification: ————————————————  ‘wrap siyle: [haone] -
Harizantal: [l = ¥ Force wrap? -
Wertical EHE=1= Delirniter l_

Font... | M| [Click Fort...]
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23. Click on a column in the top section (circled above, containing the text Business School). The S+

field (accessor) relating to this column is shown (

, just beneath the Add button).

24. This example will now work through three scenarios — changing the contents of a column,

removing a column, and adding a new column.

25. We need to change the Module ID column to display the module name. Click in the Module ID

column to select it.

preadsheet Column Editor —lo] x|
Mame of Department Activity Mame Achvity D Size Module D Day Time  Dwration Staff [delimited)
Buginess School  |LUBS313001/5MR 1/06 [#5PLUS07DEOE 23 Ta11Y Fri 10:00 1:00  |Leonidou.Constantinos,Dr Buisiry
Business Schoal |LUBS100002/LEC 1/01 [#SPLUSO7DESD 83 27375 Thu 11:00 200 |Undenwaood, Sarah/Duff Genard [Parki
Business School  |LUBS101002/LEC 1/01 [#SPLUSD7DEEZ a0 alaih Mon 3.00 200 |Undenwood, Sarah Iicha

o |

Bemove | & Edit Selected Column

0 Editall
 Edit Column Titles

Activities
+ Module

[V Show Grid Lines?
¥ Show Columin Titles?

ALk

0K

Apply

Undo

Cancel

Data Format:

Colours: Shading: Column
Test: [none) i Colour: I [none j I [none)
Background: [nonel - Texture: [rane] -

|—Justification: | Wirap style: [none) -

L.

26. The currently selected field (or accessor) —i.e. Module Host Key — is highlighted, as circled above.

Click Activities, at the top of the list, to expand the options.
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Activity 1D Size  ModulelD  Day  Time  Duration Staif [delimited] Location (deimited)

Business School _|LUBS319001/SMR 1/06[RSPLUSO7060E | 23 I F 1:00_|Leonidou, Constantinas, Or [Business School Maurice Keyworth SR (1.04]3, 5, 7, 9,
Business School LUBS100002/LEC 1/01 BSPLUSO70ESD| B8 | 27ars 2.00_|Underwood, SarahD uif Genard [Parkinson SH (1,061 23,
Business School LUBS101002/LEC 1/01 [RSPLUSO7DERZ | 500|200 |Ondenood, Saiah [Michael Sadler 5 (LG.19) -

@ EdtSelected Colmn

© Edtal

"+ Achivitios —  Edit Column Titles Apply
- Activity dates

+ Activiyy Or Parents Undo
- ﬁ"‘:hww TdEEmD‘stE W Show Giid Lines?

+ Allocate: wiprent

Chlincated Locatone 2 Show Column Thies? Caneel
+Bllocated Modules

- Allocated Pooled Resources
+ Allocated Posts

T Bllooated Stait - Colours: Shading Column Data Farmat:
+ Bllocated Shudent Sets Text ol

- Ay Prablams? = [none] hd olour [none] - [none] -
- Avsilable Periods over Delivered Week Pattem B ackground Test

- Busilatle Periods over Wesk Patterm ackgroun! (none) d e [none) [

- Baoking Perinds -

- Booking Periods Distinct Jutiication: wiap style: [inere) =

. 2

; Booking Harizonak = Focewa? [

- Contact periads - i

- Cartact Perods Distinct Vericat === Delimitst [

- Contact?

- Cover Periods Font. X | [Click Font )

- Cover Peiiods Distinct

Cover?
- Daate of Scheduling
- Daps for Masimum?
- Daps for Minimum?
- Defered Resaurce Types
+ Department
- Description
- Double Bookings
- Duration
+ Equipment
- Equipment cast
+ Equipment Sulabilties
- Factar
- Host Kep
- Link Size:
- Location cost
+ Lacation Suiabilties
+ Locations
- Max Distinct Cantact Periads in a Week
- Maw Periods in a Wesk
- Mavimum Days
- Masimum Time:
- Minimum Days
- Minimum Time
- Mismatched Resource Types
+ odule

+ Named Availabiliy
+Named Start Preference
+Named Usage Preference
- Dverlap with Exported Weeks
+ Parents
- Planned Size
- Pooled Rresource cost
- Podled Resources
=l

+ Prats

27. We need to change the column to display the Module Name — find Module in this list and click
on it to expand the available options.

Spreadsheet Column Edit ;Iglil
Mame of Departrent Activity Marme Activity (D Size  Module I Daw Time  Dwration Staff [delimited]
Buginess School  |LUBS313001/5MR 1./06 [#5PLUS07DEOE 23 1811y Fri 10:00 1:00  |Leonidou,Constantinos, Dr BLisiry
Buzinezs School  |LUBS100002/LEC 1401 |#SPLUSO7DESD joi] 27375 Thu 1100 200 |Underwood, Sarah/Dulf Genard |Parki
Buginess School  |LUBS101002/LEC 1/01 [#5PLUS07DEEZ ] Atk b o 3.00 200 |Undenwood, Sarah b icha

»
add | Remove &' Edit Selected Column
0 Edital
" Edit Column Titles Spply |
- Any Problems?
- Available Periods over Week Patten Unda |
- Booking Periods ¥ Show Grid Lines?
- Booking Perods Distinct .
- Eontac%l periods ' Show Calumn Titles? Cancel |
- Contact Periods Digtinct
+Course
- Cowver Perniods . . .
- Cover Periods Distinct - Colours: Shading: Column D ata Format;
+ Department ) .
- Description Tent [nane) - Colour: I[none] j I[none] J
- Equipment cost _ )
-Host Key B ackground: [rore] - Texture: [nane] -
- Lirk Size o -
- Lacation cost rJustification: WWirap style: [nore] =
+ Mandatory Programmes . _
*Tax Urngt Contact Periods in a W Horizantal. Force wiap? r
a'lesk Wertical: BZIE Drelirniter l_
ility
Preferance Font... | 2| [Click Fant..)

zage Preference _I

=
+ MNrtinnal Proarammes
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28. Select Name from this list (indicated above).

Spreadsheet Column Editor ;Iglil
Mame of Departrent Activity Marme Activity (D Size Maodule D Day Time  Duration Staff [delimitzd)
Buginess School  |LUBS313001/5MR 1./06 [#5PLUS07DEOE 23 = THS 313007 Fri 10:.00 1:00  |Leonidou, Corstantinos, Dr Eu
Buzinezs School  |LUBS100002/LEC 1401 |#SPLUSO7DESD joi] | JBS100004  Thu 11:00 200 |Underwood, 5arah/Dulf Gerrard [P
Buzinezz School  |LUBS101002/LEC 1401 |#5PLISO7DERR 1] WESI00E  Mon 500 200 Underwood, Sarah ki

|

»
add | Bemove | &' Edit Selected Column
p 0 Edital
chivities
| + Module ¢ Edit Calumn Titles Apply |
other Unda |
¥ Show Giid Lines?
¥ Show Column Titles? Cancel |
r Colours:; Shading: Column D ata Format:
Text [mone] = Colour: I [none] j I [hone] j
Background: [hone] - Texture: [none] -
—Justification: Wwrap style: [nore] =
Horizontal: e = T Force wiap? r
Wertical: BZIE Drelirniter l_
Fart... | Xl [Click Font...]

29. The contents of this column will update. Finally, you need to update the column header.
Double-click on the text (Module ID in this example) and select other... from the list which
appears.

30. Edit the text as required and press the Return key on your keyboard. You must press the Return
key for the changes to be accepted. If you move to another column using the mouse, the
column header will revert to its original value.

31. When you are happy with your changes, click on the Apply button and the template will be
updated.

32. We also need to remove the Staff, Location, Weeks and Teaching Week Pattern columns from
the template. Click on the Staff column, then click on the Remove button. Repeat for each of
the other columns to be removed.

33. Click Apply to update the changes in the template.
34. Finally, we need to add a new column between the Size and Module Name columns.
35. Click on the Size column, and click Add. This will create a second Size column.

36. With this new, second column selected, click on Activities in the Accessor (or fields) box, and
choose Scheduled? from the list that appears. The column will update accordingly.
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37. Click Apply and OK to finish.

38. On the right of the screen, check that the correct template name is displayed, and click Create
Template again to ensure your changes are saved.

Please note: These actions can be carried out to add or remove any columns from your report as
required. When you have added all required columns to your report, remember to change the
column heading by double-clicking on each one, selecting other... and entering the text you require.
If the report you wish to create or edit is a timetable grid, this can also be done through S+ print
templates. However, we recommend that you contact Timetabling & Room Bookings to discuss the
best way to generate the report you require.

Creating templates

You may wish to create a new template if there is no existing template for you to adapt.

1. From the Timetabler menu, open the screen that you want to report on — for this example,
select Locations.

2. Filter to the locations you need to include in your report by selecting Filter from the View drop-
down menu. Either press Ctrl and A to select all locations in this list, or click on the locations you
want to include, whilst pressing the Ctrl key to multiple select.

3. Select Print... from the File menu.

Print Style x|

Spreadsheest

Test Spreadsheet
Text Repart

[rote]
Generc Object List

P —

Wwhieeks to Prink:
1 &5 10 15 20 25 30 35 40 45 A0
CECECEEETEE T EE e e e e e ey

[T Show all Templates?

Template Organizer... | Erirt &ll... | Fresdiew... | Eile... | Cancel |

4. Select Spreadsheet and (none) as circled above, and click Preview....
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€% spreadsheet Print Location

No Template Selected

5. Click Edit (circled above).
[

6. Enter the name of your template in the box on the right of the screen, as indicated above, and
change the Template Class drop-down box to Location. If you are creating a report in another
area of S+, Template Class should be changed to the name of record type, e.g. Staff, Activity,
Activity Template, etc.) that you are creating the template for.

7. Click Create Template.
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readsheet Print Location

<Click HERE to Edit Header>
Home
Clothumorkoers Cenaril Euildng CAD (WD 173)
Clothwroiers Central Building CAD (WD 177
Clothwmarkers Cararad Building MR (WD 167)

Clothurortiers Cezrl Building SE 1 (WD 160
Clothurodiers Cantrd Euilding SE 2 (WD L61)
Cloftomeriers Central Building SB 3 (WD GR12)
Clofturoriers Central Building S & (WD BE.75)
Clottumarkers Carrd Building SR 54 (WD GF.763)
Clothroers Central Building SE S (WD GR.76h)
Clotkwmarkers Carardl Building Terting (WD GE.T20)
Nttt Conmal Building Vis Com Suite (WD 5R.17)]
Clotturoriers South Building Krtting (1.04)
Clofbumerkers South Euilding Prive (GE0T)
Clottearksers South Building Weaving (1 04b) T emplate Class:
Lak Building CAD (L 1364)
Link Building CAT (L 139)
Lirk Eilding MA (L GF. 532) Options
Link Building DA (L GR. 0320)

Templats name here

Cieats Templats

Template Organiser

Parameters

‘

8. A “Name” column will appear in the report. You can then continue to add and edit columns,
header, and footer as described in the previous section, Editing Templates.

9. When you have finished, click Create Template again to ensure that your changes have saved.
Click Print All if you want to create a printout immediately.
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Section 4: Saving print templates

If you create or change a print template in S+, it is advisable to save it outside your current image.
This means that you will be able to use your template even if you need to retrieve a new image from
the Timetabling & Room Bookings website.

1. From the File drop-down menu, select Template Organiser.

rint Template Organiser - IEI IEI
StudentSet Module L:I CreateStudentLiszt :I
congec actz <[Dielste *COMF achivity hst
CreateStudentLizt *Conf Office List
“COMF achivity list Copys» “weekly booking she

“weekly booking she tezt Activity List
“Student data Template name here
test Achivity List Courze |ndividual
:Template name here

*Canf Office List J —_— 1 I=Student data

[Veletes

Location Individual

Courze Indiidual <4Lopy Jaoint Module Indirad

Lu:u_u:atiu:un Inu:liviu:lL_Ja_I j kodule Inu:li'-.fiu:lL_JE!I j

b ernon j I M ermom j
Save bz | Open... |

Claze |

2. Inthe box on the left, select the name of the template you wish to save, and click the Save As...
button.

Save Print Template x|

Save All

r:. ....

Save Save As... | Discard |

3. Select Save Selected and click the Save As... button.

4. The Windows Save dialogue box will open. Choose a folder into which to save your template,
type a filename into the File name box (circled below) and click Save. When typing a filename,
simply replace the asterisk with the name. The file should always end .ptm.
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Save Print Template

Save jn: IE}F‘rinting j ] i

Deszktop

¢

tdy Computer

j Save I
Al Files [*%) | Cancel L
o

5. When you next need to use this print template, you can import it into S+ in addition to the

File name:

Save as lype:

default print templates which are already loaded in the image you retrieve from our website.

6. From the File drop-down menu, select Template Organiser. You will see that the default
templates are already loaded.

1ol x|

rint Template Organiser

7. Click on Open... (circled above), and navigate to where you have saved the print templates which

you have created.

Programme List Spre «
“Class lish/LE

Data Report

*Booking Confirmatio
*SHC Booking Confir
Location Master
Location Uzage
Location kMaster DD
Generc Object List
Activity List

<[lelete

] ]

[Neletes

<<[Copy

StudentSet Maodule I.j

Cloze |

Programme List Spre «
*Class list/LE

Data Report

*Booking Confirmatio
*SHC Booking Confir
Location b azster
Location Uzage
Location kMaster DD
Generic Object List
Activity Lizt
StudentSet Maodule Lﬂ

I b ermory j

Open... |
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rint Template Organiser _ o] x|

Frogramme List Spre a

<[Dielete “Clasz listLE =
= |Data Report

Copys> *Booking Confirmatio
— 1 |*5HC Booking Confir—
Location Master
Location Uszage
Location Master DD
Generic Object List

<Lapy Achivity List
= |StudentSet Module L;I

template name here. j IMemDr_l,l j
Save Az | Open... |

Cloze |

8. Select the name of the template(s) you wish to import in the list on the left, then click Copy>>.
The template will then be added to the list on the right. You can then close the Print Template
Organiser window.

[eletes

9. Itis recommended that you do not over-write the print templates provided with S+. If you have
edited one of these templates, please save it using a different name.

This is the end of the manual. If you have any questions, please don’t
hesitate to contact Timetabling & Room Bookings on 34009 or, by email

on timetable@Ieeds.ac.uk.
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